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Stampa e prestampa

Stampa industriale
	 Offset piana e rotativa
	 Flessografica
	 …

Prestampa
	 Cioè dall’originale alla lastra
	 È un flusso di lavoro (prepress workflow)
	 Qui avviene la gestione del colore
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Flussi di prestampa moderni 

Esperienza decennale degli stampatori•	
Esperienza decennale degli sviluppatori•	
Prepress workflow systems•	  moderni
Formato PDF/X è stato sperimentato•	
Adobe Creative Suite CS3 ha gli strumenti necessari•	

in arrivo
Adobe PDF Print Engine (supera PostScript)•	
PDF/X-4 (supporto trasparenze)•	
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Decisioni in un flusso di prestampa

Quando convertire in quadricromia RGB > CMYK•	
Quali profili RGB e CMYK usare•	
Che formato mandare al RIP del •	 plate setter
Che versione di PDF utilizzare•	
Come trattare i colori spot (Pantone)•	

Ma la prima decisione è …
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Profilo CMYK di stampa offset finale

Profilo ICC della macchina da stampa offset finale
	 Se fornito dallo stampatore

Profilo ICC standard di macchina a norma ISO 12647-2
	 Profili forniti da Adobe
	 Profili scaricabili da ECI (European Color Initiative)
	 Profili personali creati dalle caratterizzazioni FOGRA
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Perché scegliere eventualmente altri profili?

Perché, pur essendo tutti basati sulle caratterizzazioni 
FOGRA, profili diversi possono avere

diversa partenza del nero				    (per es. Adobe: 45)•	
diverso TIL (•	 total ink limit)				   (per es. Adobe: 350)
diverso nero max						      (per es. Adobe: 100)•	
diverso UCR, GCR•	
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Profilo CMYK di stampa finale

Profilo dello stampatore

Profili CMYK Adobe
	 Coated FOGRA27 (carta patinata lucida e opaca)
	 Web Coated FOGRA28 (patinatino per rotooffset)
	 Uncoated FOGRA29 (carta usomano, naturale, non patinata)

Altri profili CMYK
	 Già pronti, scaricabili da web (ECI, IFRA, …)
	 Generati da caratterizzazioni FOGRA



Gestione digitale del colore in stampa e prestampa | Milano | 13 giugno 2007

Mauro Boscarol

Tre flussi di prestampa

! Early binding
	 CMYK fin dall’inizio per tutta la grafica

@ Mixed binding
	 Flusso intermedio

# Late binding
	 CMYK per grafica nativa, RGB per grafica importata
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Early binding
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Flusso early binding

Flusso tradizionale,  più utilizzato, più prudente•	
Tutto in modalità CMYK finale•	

I due successivi flussi sono varianti di questo flusso •	
E introducono la modalità RGB•	

Vediamo lo schema del flusso, poi entriamo nei dettagli
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La conversione in CMYK  
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Apertura in Photoshop CS3

Apertura immagini RGB (modalità prevista dal flusso)
	 mantenere il profilo se è presente (automatico)
	 altrimenti assegnare sRGB o Adobe RGB

Eventuali immagini raster CMYK (da evitare)
	 mantenere il profilo se è presente (automatico)
	 altrimenti assegnare il profilo CMYK finale
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Conversione in CMYK
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Seguono le correzioni tonali e cromatiche

Correzioni tonali
	 Punto bianco, punto nero
	 Luminosità, contrasto
	 Maschera di contrasto
	
Correzioni cromatiche
	 Dominanti
	 Saturazione
	 …
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Anteprima in Photoshop CS3

Compensazione monitor
	 senza simulazione del bianco e del nero •	
	 (colorimetrico relativo con compensazione punto nero)

	
Soft proof

	 con simulazione del nero•	
	 (colorimetrico relativo)

	 con simulazione del nero e del bianco•	
	 (colorimetrico assoluto)
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Soft proof in Photoshop CS3
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Anteprima in Photoshop CS3

Hard proof
	 senza simulazione•	

	 (colorimetrico relativo con BPC)
	 con simulazione del nero•	

	 (colorimetrico relativo)
	 con simulazione del nero e del bianco•	

	 (colorimetrico assoluto)
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Salvataggio da Photoshop CS3

Formato grafico
	 PSD o TIFF
	 Evitare JPEG (la compressione può essere pericolosa)
	 Evitare EPS (una complicazione inutile)

Profilo CMYK incorporato
	 In questo flusso è superfluo
	 Ma va incorporato sempre, per informazione
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Punto della situazione

A questo punto tutte le immagini raster 

sono convertite nel CMYK finale•	
hanno incorporato il profilo CMYK di stampa finale•	
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Nomenclatura

Inchiostri di stampa
		  di quadricromia			   speciali

Colori, con riguardo agli inchiostri con cui vengono stampati
		  di processo o				    spot (p. e. Pantone)
		  di quadricromia

Colori, con riguardo alla loro definizione
		  CMYK (< RGB, Lab)			  libreria (nome e Lab)
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Due tipi di colori in Illustrator CS3

1

Colori “di processo” definiti in CMYK 
e da stampare con inchiostri di  quadricromia

2

Colori “spot” definiti con una libreria 
e da stampare con inchiostri speciali
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1 Colori di processo definiti in CMYK



Gestione digitale del colore in stampa e prestampa | Milano | 13 giugno 2007

Mauro Boscarol

Colori spot definiti mediante una libreria
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Uso dei colori spot

	 Solo se è previsto di usare inchiostri speciali•	
	
	 Il 70% dei colori Pantone solid coated  
	 non si possono stampare in CYMK
	 e l’altro 30% viene male in CMYK

	 Sempre definiti in Lab (non in CMYK, né RGB)•	
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Colori spot sempre definiti in Lab

	 Windows > Swatches > Spot Color
	 Windows > Swatch Libraries > Color Books
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Anteprima in Illustrator CS3

Compensazione monitor
	 senza simulazione del bianco e del nero •	
	 (colorimetrico relativo con compensazione punto nero)

	
Soft proof

	 con simulazione del nero•	
	 (colorimetrico relativo)

	 con simulazione del nero e del bianco•	
	 (colorimetrico assoluto)
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Soft proof in Illustrator CS3
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Anteprima in Illustrator CS3

Hard proof
	 senza simulazione•	

	 (colorimetrico relativo con BPC)
	 con simulazione del nero•	

	 (colorimetrico relativo)
	 deselezionare BPC nei Color Settings

	 con simulazione del nero e del bianco•	
	 (colorimetrico assoluto)

	 Advanced > Overprints > Simulate•	
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Punto della situazione

A questo punto tutte le immagini raster e vettoriali

sono nel CMYK finale•	
hanno incorporato il profilo CMYK di stampa finale•	
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Grafica in InDesign CS3

Grafica importata
	 da Photoshop CS3, CMYK (Coated FOGRA27)
	 da Illustrator CS3, CMYK (Coated FOGRA27)
	
Grafica nativa
	 Sempre senza profilo
	 Si riferisce al profilo di lavoro CMYK (Coated FOGRA27)
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Importazione da Photoshop CS3
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Importazione da Illustrator CS3

Non ci sono opzioni sul colore
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Grafica nativa come in Illustrator CS3

Colori “di processo” in CMYK (inchiostri di quadricromia)
Colori “spot” da libreria in Lab (inchiostri speciali)

	

Pantone si scelgono i n Swatch Options > Color Mode
Ink Manager è una opzione della paletta Swatches
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Anteprima in InDesign CS3

Attivare View > Overprint Preview
Attivare Window > Output Separations Preview
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Soft proof InDesign CS3

Impostare View > Proof Setup e attivarla
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Punto della situazione

A questo punto sono state impaginate tutte le immagini 
raster e vettoriali in CMYK, senza profilo.

Anche la grafica nativa è in CMYK.

Il profilo CMYK di documento di InDesign è il profilo CMYK 
comune a tutta la grafica, importata e nativa.
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Generazione del PDF

Esportazione da InDesign CS3
	 Se il prepress workflow system lo accetta,
	 creare un PDF/X-1a, altrimenti un PDF 1.4 o 1.5

Non usare PostScript e Distiller
	 Tecnologie superate
	 Stanno per essere sostituite da PDF Print Engine
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PDF/X-1a

È un normale PDF con
	 alcune cose obbligatorie (font, ...)
	 alcune cose proibite (audio, …)

Gestione del colore
	 tutta la grafica è in CMYK e/o colori spot
	 il PDF contiene un unico profilo CMYK (output intent)
	 gli spot sono descritti in Lab
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Punto della situazione

A questo punto abbiamo un PDF/X-1a, in cui 

tutti gli oggetti grafici sono in CMYK •	
l’output intent (il profilo comune) è Coated FOGRA27•	

Per verificarlo lo apriamo in Acrobat e facciamo un 
preflight
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Controllo in Acrobat 8

Advanced > Print Production > Preflight
	 Conformità PDF/X-1a
	 Output intent
	 Immagini e profili
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Preview di stampa

Advanced > Print Production > Output Preview
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Questo è il flusso early binding

Il PDF creato ha tutti gli elementi per essere stampato 
correttamente.

Il PDF viene trasmesso allo stampatore, che lo apre con il 
suo sistema di prestampa e lo processa.

Se il sistema di prestampa è aggiornato, include il modulo 
di gestione colore e lo stampatore ne conosce il funzio-
namento il suo lavoro, i colori verranno stampati corretta-
mente.
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Nessuna conversione di colore per RGB

Le immagini raster RGB rimangono in RGB
	 se hanno un profilo, lo mantengono
	 se non hanno un profilo, assumono quello di default
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Salvataggio

Con profilo incorporato
	 PSD
	 TIFF
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Grafica in InDesign CS3

Grafica importata
	 da Photoshop CS3, RGB (per es. Adobe RGB)
		  con profilo incorporato, impostare l’intento di rendering
	 da Illustrator CS3, CMYK (Coated FOGRA27)
		  senza profilo incorporato
	
Grafica nativa
	 creata in CMYK o spot
	 si riferisce al profilo di documento CMYK (Coated FOGRA27)
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Generazione del PDF

Impostazioni come nel flusso •	 early binding
La conversione RGB > CMYK avviene qui•	
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Vantaggi

Maggiore flessibilità•	
Le immagini raster rimangono temporaneamente RGB•	
Non è necessario convertirle una ad una•	
È sempre possibile assegnare un intento di rendering•	
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Flusso late binding

Le immagini RGB rimangono RGB•	
Il PDF creato è un PDF/X-3•	
La conversione in CMYK avviene nel sistema di prestampa•	
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Vantaggi

Massima flessibilità
Le immagini RGB restano tali sempre
Gestione del colore nel sistema di prestampa
Evita problemi di conservazione del nero K
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Considerazioni finali

Early binding
	 Oggi il flusso più comune

Mixed binding
	 Poco usato
	 Conversione in CMYK automatica

Late binding
	 Pochissimo usato
	 Non richiede conversione in CMYK	
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Considerazioni finali

Sono flussi già pronti per le novità

Oggi il passaggio da early a late è complicato dalla 
presenza di PostScript e dalla mancanza di un 
PDF/X che supporti le trasparenze
	
Con PDF Print Engine e PDF/X-4 (in arrivo)

si possono usare gli stessi flussi•	
è più conveniente usare •	 late piuttosto che early
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Finisce qui, grazie

Maggiori informazioni su

	 http://www.boscarol.com

Iscrivetevi al gruppo colore_digitale

	 http://it.groups.yahoo.com/group/colore_digitale

	




